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INTRODUCTION TO ROOTSNAP! 

What is RootSnap!? 
RootSnap! is a faster and more reliable method for analyzing root images.  It includes a 
revolutionary user interface that employs a combination of advanced image analysis and a 
multi-touch LCD screen, which allows users to quickly and easily trace roots using their 
fingers.  Root tracing enhancements, such as the “Snap-to-Root” feature that “snaps” root 
tracing points to the center of the root automatically, removes hours of tedious point-by-
point outlining of roots.   
 

What are the Design Intents of RootSnap!? 
RootSnap! features integrated image enhancement enabling users to optimize the scanned 
image for more accurate processing.  Roots are mapped in a fraction of the time using the 
automated image analysis, the touch-screen interface, and the Snap-to-Root function.  This 
software is designed to be user friendly, intuitive and time efficient.  Files are stored as 
RootSnap! project (.rsp) files, and the application easily exports data to other software, such 
as Microsoft Excel.   
 

What is RootSnap! Actually Used For? 
RootSnap!’s many features and the Snap-to-Root function can be used to monitor root 
growth, death and the occurrence of disease.  More than a dozen parameters are calculated, 
including root length, area, volume, diameter, and angle of growth.  A time-series root 
analysis feature allows for saving and reusing root trace information across images 
captured in multiple sessions. 
 

What is the Snap-to-Root Function?  
The underlying function that makes RootSnap! user friendly and time efficient is the unique 
“Snap-to-Root” feature.  When enabled, a root drawing that has just been traced will 
automatically “snap” to the center of the actual root.  The center of the root is determined by 
the matching the identical color as the last root point, within the range of the tool, for  the 
next root point.   
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GETTING STARTED 

After the RootSnap! software is installed on a touchscreen computer,  the application can be 
accessed from the Start Menu or by double-clicking on the RootSnap! icon on the desktop. 
 

Automatic Update Feature 
RootSnap! has an automatic update feature for downloading the latest version of RootSnap!.  
If the computer has an internet connection, RootSnap! users will automatically be notified 
that an update is available when starting the application.  Each time the program is opened, 
the software will take a few seconds to verify that the proper system requirements are in 
place to run the software, as well as to search for any updates available if the computer is 
online.  If an update is available, the user can choose to update (start the application and 
choose update when prompted) or revert to a previous version of software by using the 
add/remove programs feature in Windows.  When an internet connection is not available 
while starting the software, the automatic update feature will be skipped and the last 
version downloaded onto the computer will be opened.   
 

Versioning 

The version numbers for this application is defined numerically as: 
major.minor.build.revision (ex: Version 1.2.9.17).  Major increments increase when a new 
version is released.  Minor increments indicated when functionality changes are made.  
Build increments indicated that defects have been corrected.  Lastly, the revision increment 
increases every time the software is changed in any way.  
 

Software Website 

To install or update RootSnap! navigate to the CI-690 product software webpage 
(http://www.cid-inc.com/support/software-downloads).  The software page will show the 
name of the application, current version and the publisher [CID Bio-Science, Inc.).  Before 
installing the RootSnap! application, two Windows modules are required: 

 Windows Installer 4.5 

 Microsoft .NET Framework 4 (x86 and x64) 

http://www.cid-inc.com/support/software-downloads
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License Key Activation 
RootSnap! software incorporates a license key, which must be activated with CID Bio-
Science, Inc.  Any questions or problems with activating the license key should be directed 
to support@cid-inc.com.  To activate the license key: 

1. Install the RootSnap! software. 

2. With the computer connected to the internet, open RootSnap! 

3. Follow the instructions on the pop-up box to activate the license key. 

 

After the license key has been activated, the <Help><About> screen will show the License 
key information.  If the key is not activated, the number of days remaining in the trial 
version will be shown below the License key.  There is a button to initiate a check for an 
update to the software.  It is a good idea to check for updates every few months if the CI-690 
computer is not usually connected to the internet.  Make sure to connect the computer to 
the internet before attempting to update the software. 

 

 

 

 

 

 

 

 

 

 

Hardware Requirements 
RootSnap! is designed to run at 1920 x 1080 (HD 1080p) on Windows 7 or Windows 8.  
Table 1 displays the minimum system requirements for running the RootSnap! application.  
The CI-690 RootSnap! software is designed to work with a touch-screen monitor.  Using a 
touch-screen will increase the speed and ease of analysis, as well as eliminate repetitive 
point and click motions with the mouse.  RootSnap! is compatible with both 32 bit and 64 
bit PC’s.   
 
Table 1: Hardware requirements for running RootSnap! software. 

Operating System Windows 7 or 8 
CPU Dual Core or above 
RAM 2 GB 
Video Card 512 MB dedicated 
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OPERATING INSTRUCTIONS 

To begin using RootSnap!, an image of a 
root or root system needs to be imported 
into the program or an already saved 
project or session can be opened.   The 
Menu Bar displays File, Edit, View, and 
Help.    Several specific terms are used to 
define some of the features and functions 
of RootSnap!  Images, root maps, 
windows, sessions and projects are all 
defined and outlined in Table 2.  The 
figure to the right shows the project data 
outline, listing root tubes and then each 
window, with the date and time (session).  
Here, Tube 2, Window 1 has two session 
images loaded into the project.   
 

 

 
Table 2: Frequently used RootSnap! terms, definitions and details. 

Term Definition Important Details 

Image 
A picture file that is imported into 
RootSnap! 

Use the CI-600 Digital Root Scanner to easily capture 
images for analysis.   

Root Map 
The lines (roots and branches) that are 
traced on the imported image 

Use migrate roots feature to transfer root maps 
between sessions. 

Tube 
Clear plastic tube in ground that image 
was captured inside of.   

Images can be imported from one tube or from multiple 
tubes 

Window 
Categorizes images by depth from the 
surface within an individual root tube  

Import images into multiple windows in a tube in order 
to form a continuous image of a single tube from top to 
bottom. 

Session 
Categorizes images by the date the 
image was captured, from same tube. 

Build sessions with multiple images from different 
dates and times to illustrate root behavior. 

Project 
A project file saves root maps, branches 
and points from all imported images.  

Projects can be expanded to contain multiple tubes, 
windows and session images and their root maps. 
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Windows Experience Index 
If an error message appears stating that the computer’s Windows Experience Index (WEI) 
score does not meet the minimum 4.5 required for RootSnap!, click “ok”. Computer's with 
WEI scores that are lower than the minimum will still run RootSnap!, but the system may 
hesitate briefly before some operations occur. The software will still function properly.  This 
message only appears when the application is opened.  If the WEI score is above 4.5, the 
message will not appear. 
 

 
 

Import an Image 
The import feature gives the user the ability to import images and populate a RootSnap! 
project with multiple images naming them using the information in their ICAP (Internet 
Content Adaption Protocol) based file names.     
 
During the import process, the user can preview images which are about to be imported.  
However, the user cannot zoom or pan around the preview images. The Pan & Zoom tool 
can be used once an image is imported into a project.   
 

 To import an image, select <File> 
<Import > or press Control + I  

 Browse the computer or enter the file 
name of the image you wish to 
import. 

 
The application uses the DPI (dots per inch) 
of the image to determine the correct size 
and measurements of roots.  For example, an 
image with a resolution of 1024 x 768 at 300 
DPI has a physical area of 86.614 x 65.024 
mm.  Images of any DPI are supported by 
RootSnap!, however extremely high 
resolution images (+1200 DPI) may require a 
fast CPU to run smoothly.   Various image file 
types can be imported and analyzed, such as 
JPEG, GIF, TIF, TIFF, PNG, BMP, etc.   
 
 



CI-690 RootSnap! Operations Manual rev.1/24/14 

 

1554 NE 3rd Ave, Camas, WA 98607, USA  

Phone (360) 833-8835 Fax (360) 833-1914   sales@cid-inc.com   http://www.cid-inc.com 
6 

 

 

Scanned images from the CI-600 Digital Root Scanner are 215.9 mm x 195.7 mm.  The DPI 
and Pixel count are automatically adjusted to render this size.  Typically the DPI, Pixels and 
Actual Size values do not need to be changed from the values automatically tagged with the 
image.  The user should always check to ensure that the computed data conforms to what is 
expected.   
 
To check if the actual size of the image is correct, or to change it to the correct size before 
starting to analyze roots,  access the Image Details Panel by navigating to 
<View><Panels><Image Details>.  
 

 
 
The Image Details panel will appear on the left side of the screen 
when enabled.   
 
The “Physical Size” of the image is displayed in millimeters.  
Check that the image’s Physical Size is correct.  If the actual size of 
the image is not correct, change it to the correct size before 
starting to analyze roots.   
 
CI-600 images are 215.9 mm x 195.7 mm.  The DPI and Pixel 
count are automatically adjusted to render this size.  Typically the 
DPI, Pixels and Actual Size values do not need to be changed from 
the values automatically tagged with the image.   

 
If there are multiple images in a project and the physical size is 
changed, a message will appear asking if you would like to resize 
all the images in the tube.  The program can accommodate non-
equal size images and windows in the same tube or session. 
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 Estimate Root Percent 
After an image is imported and the actual size is 
correct, the image’s root/soil separation 
threshold should be set.  Click the Estimate Root 
Percent icon on the toolbar.  Adjust the 
threshold level and select the best image.  The 

best image has neon green overlaying only the roots and 
none of the soil.  Choose from Dark Soil/Light Roots or Light 
Soil/Dark Roots to help set the best threshold. 
 

 

 
This tool estimates how much of the root system is shown in the image.  After the threshold 
is set and you click “Apply”, the estimated root percent statistic will appear in the Image 
Details Panel.   
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Window Alignment 
Images taken with the CI-600 Digital Root Imager typically have 1 cm of overlap in order to 
guarantee that the entire root area and all parts of the tube are scanned.  Multiple images 
may be lined up and have the overlap removed using the Window Alignment tool on the 
Image Details panel. It is easy to accurately eliminate the overlap and make sure that all 
scanned roots are fully included in the analysis.  Window images can be aligned using this 
feature.  If root mappings from previous session images need to be aligned, please see the 
“Migrate Roots” section of this manual.   
 
To align window images: 

 Load the images into RootSnap!. 

 Starting with the second window from the top (Window 2), the Window 
Alignment button is at the bottom of the Image Details Panel.  If you cannot see 
the Window Alignment button, check that RootSnap! is in full-screen mode 
(show/exit full screen button on right of tool bar) and check that Window 2 or 
lower is selected. 

 To see the Image Details Panel, select View<Panels<Image Details from the top 
menu bar.  

 

 

 Pressing the Window Alignment button will initiate a pop-up window.   

 Align the images from Window 1 and Window 2 using the mouse or fingers.   

 The images will become transparent where overlapping.  This is in order to help 
accurately line up the images and roots. 



CI-690 RootSnap! Operations Manual rev.1/24/14 

 

1554 NE 3rd Ave, Camas, WA 98607, USA  

Phone (360) 833-8835 Fax (360) 833-1914   sales@cid-inc.com   http://www.cid-inc.com 
9 

 

 

 Use the mouse or fingers to fine-tune the exact overlap in the transparent “ghost 
effect” area.  Align the images by overlaying the roots.   

 Click <Apply> at the top of the screen when images are aligned or click <Cancel> 
to exit the crop and align feature. 

 

 
 

 The images will reflect the alignment in the preview on the Tube Details panel.   

 The Window Alignment tool should be used for each window, starting with Window 
2, before root mapping is started.   
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Beginning to Map Roots 
Once a root image is imported into RootSnap!, estimate the root area and align it with 
neighboring window images to be ready to begin mappings roots.  Select a window image to 
start mapping.   
 

1. Import image. 

2. Rotate/flip the image. 

3. Verify correct physical size in Image Details Panel. 

4. Window alignment (if lower in tube then Window 1). 

5. Adjust image Brightness, Contrast and Gamma 

6. Estimate root percent. 

7. Zoom in on root to map until it is at least as wide as your finger. 

8. Place the first point in the center of the root.  The first point is critical; it 
must be on the root! 

9. Detect growth. 

10. Check automatically mapped points for accuracy and diameter. 

11. Move/place points past color change to keep automatically detecting 
growth. 

12. Detect growth again. 

13. Start mapping branches: 
a. Map a few points and detect growth. 
b. Dock branch to parent root. 

14. Detect growth.   
a. Move points to end of branches.   

15. Continue for rest of root system. 
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TOOL BAR OPTIONS 

Undo & Redo 

This tool allows users to undo or redo changing roots, 
adding points, moving points, deleting points, etc.  It also 
allows the user to undo/redo changes to the root image.  A 
current Session needs to be loaded to use these tools.  
Undo/redo can be used multiple times. 
 

Pan & Zoom 

The Pan & Zoom tool functions so that the user can pan around the root 
image and zoom in or out on the image.  Touching the icon twice will display 
a hidden menu with “Instructions” for the Pan & Zoom tool.  These 
instructions are displayed in the Figure below.   

 

 To activate the Pan & Zoom tool, select it from the Tool Bar by touching the icon or 
clicking it.   

 Pinch in or out on the root image to zoom.  This is done by touching the screen.   

o Place your index and thumb about three inches apart on screen over where 
you want to zoom in.   

o Touch the screen and start moving index and thumb towards each other.  
This should cause the image to zoom in on the center of where you touched. 

 To pan, touch or click the <pan/zoom> tool and then touch the image, move your 
finger in the direction to pan and then lift your finger off the screen.  Pan around the 
root image until finding the desired root to be mapped. 

 The middle wheel of the mouse is enabled with a pan shortcut, to help when using 
other tools but needing to move around on the image. 
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Add/Edit Points 

This tool functions to add new root points or move existing points.  To add a 
new root point, touch or click the <Add/Edit Points> icon in the Tool Bar.  
Then, touch the desired place to add the root on the root image and trace your 
finger or cursor along the length of the root to add points.   After you draw or 
move points they are analyzed and data for diameter, etc. is updated.  First, the 

snap-to-root feature is applied, and then the trajectory is plotted and finally the point is 
measured.   

 To add points to an existing root, zoom in to the root until it is as wide as your 
finger.   

 Touch/click the <Add/Edit Points> icon on the Tool Bar.   

 Touch the root directly in the center.  Place the first root point in the middle of the 
root.  The first point is critical; it must be on the root.   

 Touch/click/drag the cursor up or down the root to continue adding points.   
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When the <Add/Edit Points> icon on the Tool Bar is clicked or touched, access to the Range, 
Snap To Root and the Instructions is seen.   
 

 

 

Range 

The range around the finger touch or click that will select a currently mapped point to move 
it can be adjusted in the Move/Add points tool menu.  There are 3 preset range sizes (large, 
medium and small) with corresponding circles that represent the range of the area that will 
be selected.  The exact size will change depending on how zoomed in the image is.  The 
range can also be set from 0.25 mm to 10 mm using the drop-down feature.  Each range will 
have default point spacing.   

Snap To Root 

The Snap To Root feature, as explained in the Introduction section, will automatically “snap” 
all the points in a traced root path to the center of the root based on finding the identical 
color within the range of the tool.  Adjusting the brightness, contrast and gamma, as 
discussed in later sections, can help the Snap To Root feature determine more accurately 
where the center of the root is in the image.   
 
Sometimes mapping small or fine roots, or mapping areas where lots of roots are growing 
next to each other can be difficult if the Snap To Root feature is enabled. Snap To Root looks 
for the identical color in the gradient and identifies that as the center of the root and moves 
the root point to it.  

If the application keeps moving your root point from where you would like it: 

 Select the Move/Add Points tool pop-up menu 

 If Snap To Root is enabled, it is visible with a check next to “Snap To Root “in 
the menu.  If Snap To Root is disabled, there will be no checkmark. 



CI-690 RootSnap! Operations Manual rev.1/24/14 

 

1554 NE 3rd Ave, Camas, WA 98607, USA  

Phone (360) 833-8835 Fax (360) 833-1914   sales@cid-inc.com   http://www.cid-inc.com 
14 

 

 

 

 



CI-690 RootSnap! Operations Manual rev.1/24/14 

 

1554 NE 3rd Ave, Camas, WA 98607, USA  

Phone (360) 833-8835 Fax (360) 833-1914   sales@cid-inc.com   http://www.cid-inc.com 
15 

 

 

How to Add a Branch 

To add a branch: 
1. Touch or click the 

<Add/Edit Points> 
icon in the Tool 
Bar.  

2. Select the point on 
the parent root 
that has the 
branch.  Move this 
point to the base 
of the branch. 

 

 

 

 

 

 

3. Start at the tip of 
the branch and 
using the Add/Edit 
Points tool, add 
points towards the 
parent root.   
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4. Hover over the 
root point on the 
parent root to 
dock the branch.  
This will add the 
branch to the 
parent root.   

 

 

 

 

 

 

 

 

5. View data about the parent root in the Root Details and the Point Details panel: 
<View><Panels><Point Details> or <Root Details>.  Use the Add/Edit Points tool 
to select a point on the parent root.   
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6. View data about the branch by selecting a branch point.  A branch will have a 
current root with a decimal place.  To change the name of the root, click the box 
and type a new name.  The branch angle will also appear for points along a 
branch segment.  The branch angle will be 0o for a point on a parent root.    
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Auto Detect 

The Auto Detect tool will automatically find roots using the Snap To Root 
application of RootSnap!  In order for this feature to run effectively, the user 
should adjust the brightness, contrast and gamma of the image.  Test the Snap 
To Root feature by creating a new root path and determining if the root points 
are “snapped” acceptably to the center of the root.  The Auto Detect tool takes 

time to work and many images need to have brightness, contrast and/or gamma 
adjustments prior to running the Auto Detect tool.  
 
To automatically map a root:   

 Touch or click the <Auto Detect> button. 

 The root will grow from each end as the application searches for points to map.   

 

 When you are satisfied with the root points mapped or would like to stop the Auto 
Detect feature from working, press the <Esc> key on the keyboard.   

 Remove any points that are not correct and double-check what was mapped 
automatically. 

 Use the <Split Roots> tool to divide the root in half it the automatic mapping jumped 
between two neighboring roots.   
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Remove Points 

The Remove Points tool allows users to delete or remove points from a root.  
Removing the first point in a root path will delete the entire root path and 
connected branches. If you double-click the <Remove Points> icon on the 
Tool Bar, there is an option on the drop-down menu.  Selecting <Remove 
All…> will remove all the points in the current window.  If this is accidentally 
selected, use the Undo tool to bring back all the root points.  Clicking the 

right mouse button will enable the Remove Points tool when the Add/Edit Points tool is 
selected. 

Range 

The range around the finger 
touch or click that will be erased 
can be adjusted in the Remove 
Points tool menu.  There are 3 
preset range sizes (large, 
medium and small) with 
corresponding circles that 
represent the range of the area 
that will be selected.  The exact 
size will change depending on 
how zoomed in the image is.  The range can also be set from 0.25 mm to 10 mm using the 
drop-down feature.   

 When points are spaced close together, it is recommended to use a smaller range to 
select or delete intended points efficiently.   

Split Roots 

Enabling <Split Roots> will split the root in half when erasing a root point.  If two roots are 
accidentally docked together, or a branch is combined at the wrong point, the split roots 
tool should be used.   
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To delete points: 

1. Touch or click the <Remove Points> tool in the Tool Bar.   

2. Touch or click on or near the point(s) to be deleted. 

3. Right-click the mouse button to enable the Remove Points tool. 
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Lock Points 

This tool allows the user to lock points in place.  Once a point is locked, it 
cannot be moved from its location or be modified in any way. A locked 
point has a padlock icon in the middle of the point.  It is often useful to lock 
points near other points that are being changed to avoid mistakes.   
 

The Lock Points tool menu has options to adjust the range of the lock tool to large, medium 
or small.  The exact size will change depending on how zoomed in the image is.  The range 
can also be set from 0.25 mm to 10 mm using the drop-down feature.  The “Lock All” or 
Unlock All” tools can be selected to either lock or unlock all the points in the current 
window.   
 

 

 

 To lock or unlock points in a 
current session, touch or click 
the <Lock Points> icon in the 
Tool Bar.  Then, click/touch and 
move the blue circle over the 
point(s) to Lock.  Points that are 
locked have a padlock icon 
appear as in the figure to the 
right.   

 The points on the green root to 
the left are locked, while the 
empty points of the yellow root 
on the right remain unlocked.   
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Root Color 

The Root Color tool changes the color of a selected root.  When selected, the 
Root Color tool has a drop down panel with many shades of colors to choose 
for roots.  Branches are given a more transparent color than that of the main 
root.  Root Color will automatically change after completing a root, cycling 

through the spectrum of available root colors.  Clicking the Left button on the mouse will 
quickly cycle through the colors.   
 
To change the color of a root: 

 Touch or click the <Root Color> button on the Tool Bar 

 Touch or click the desired color on the drop down color panel. 
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Measure Manually 

The Measure Manually tool allows the user to measure a specific section of 
roots by drawing a dashed line on the workspace.  The line will disappear with 
the next click/touch.   

 

 

To use the Measure Manually tool: 

 Select the Measure Manually tool. 

 Trace a line next to the root or branch segment to be measured.   

 Trace a line through the root to estimate diameter. 

 

 

Estimate Root Percent  

The estimate root percent tool is explained in a separate section, on page 7 
of this User Manual. 
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Image Brightness 

This tool allows the adjustment of the brightness of the root image and evenly 
makes pixels brighter or darker. Brightness should be changed until it is just 
above the point where all roots are distinguishable from the surrounding soil. 
 
 

 
To adjust the root image brightness: 

1. Touch or click the <Adjust Brightness> icon in the Tool Bar. 

2. Select an image with the desired brightness or adjust the brightness using the 
trackbar. 

3. Click <Apply> or <Close> to save the changes or dismiss the buttons.   

 

 

 

 

 

 

 
 
 

 

 

 

 

 

 

The Adjust Brightness, Contrast and 
Gamma tools are great for dark 
roots in light soil or similar 
situations; they can also help to 
illuminate smaller roots or roots 
deeper in the soil. 

As image brightness increases, small 
differences in the contrast become 
visible. Contrast is the difference in 
light intensity between white and 
black. Gamma is a measurement of 
contrast that affects the mid-tones 
of an image. 
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Image Contrast 

The Image Contrast tool gives the user the ability to adjust the contrast of the 
image.  Contrast changes the shades of the images and can be used to make 
more dominant colors more intense.  Correctly adjusted contrast should make 
the distinction between root and soil clearer.   
 

To adjust the contrast: 

 Touch or click the <Image Contrast> icon in the Tool Bar.   

 Select an image with the desired contrast or use the trackbar.   

 Click <Apply> or <Close> to save or dismiss the changes.   

 

Image Gamma 

The Image Gamma tool allows the gamma setting of the image to be adjusted.  
The gamma is calculated according to a formula based on brightness and 
contrast and serves to help specific artifacts (roots) in the image stand out 
more.  A correctly adjusted gamma will make the roots “pop” from the soil and 
clearly stand out. 

 
To adjust the gamma of the image:  

 Touch/click the <Image Gamma> icon in the Tool Bar. 

 Select an image with the desired gamma or use the trackbar. 

 Click <Apply> or <Close>.   

 

Show/Hide Roots 

This tool allows the user to show or hide root paths, points or other 
markup in an open session.  To use this tool, touch or click the 
<Show/Hide Roots> button to toggle between views. 
 
 
 

 

Show/Hide Pixels 

This tool allows users to show or hide images pixels or a smoothed 
average rendering in an open session.  This tool does not have an effect on 
RootSnap!’s calculations and is available for user preference.  To use this 
tool: 

 Touch or click the <Show/Hide Pixels> button to toggle between 
views. 
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Fullscreen Tool 

This feature allows user to toggle from fullscreen mode to regular-
view mode.  
 
 
 

 

 Touch or click the full-screen button on the tool bar to switch between 
fullscreen and regular-view.   

 Press F11 to switch between the two.   
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EDIT MENU 

The Edit Menu has access to the 
Undo and Redo tools, (page 11 of 
this instruction manual) as well as 
the Migrate Roots tools. 
 
Selecting the Undo (or Redo) tool 
on the tool bar, in the Edit<Undo 
menu or by using the keyboard 
shortcut Ctrl + Z will result in the 
last action being undone.  The 
keyboard shortcut for the redo tool 
is Ctrl + Y. 
 
Selecting “Delete Current Root” will erase the currently selected root in the project.  The 
keyboard shortcut for this tool is Ctrl + Del.  The “Lock Current Root” option in the Edit 
menu will lock all the root points for the currently selected root.  The keyboard shortcut for 
this tool is Ctrl + L.   
 
 

Migrate Roots 
The Migrate Roots tool should be used to copy root mappings from Session 1 to Session 2 or 
later sessions.  Roots should be fully mapped in the first session before migrating to later 
sessions.   
 
To Migrate Roots between sessions: 

 Select the <Migrate Roots> tool from the Edit menu. 

 Select “Yes” when the following pop-up boxes appear: 
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 Press the <Ctrl> key on the keyboard and use 
the arrows to move the root mapping into 
place, overlaying the root.  Alternatively, use 
the Root Alignment Dialog to move the root 
mapping into place.   

 

 

 

 

 

 

 

 

 

 

 

 Press <Enter> to end the alignment mode or 
touch the “X” in the upper left corner of the 
Root Alignment   
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 Select a root and select the Auto Detect tool. 

 Next, use the Add/Edit Points tool to move 
the end point of the root or add new points 
to map growth.   

 
 
 
 
 
 
 
 
 

 Map the root to the new tip. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tube Angle 
The <Edit><Tube Angle> option allows the 
user to adjust the angle of the root tube.  This 
is dependent on how the physical root tube is 
installed in the field.  If the tube is installed 
vertically, the user should select the 90O 

option.  For horizontal tubes, select the 0O 
option.  For tubes installed at an angle, choose 
the 45O option.   
 

Default Root Status 
The default root status, appearing in the Root Details Panel, can be changed in the Edit 
Menu.  There are three available options for root status: New, Alive and Dead.  The default 
root status will be used for any new images imported into the project.   
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VIEW MENU 

The View Menu accesses various options and 
features of RootSnap!.  The View Menu allows the 
user to show or hide the Navigation Window, 
zoom in/out on the image, access the 4 detail 
panels, show the previous root mappings layer, 
and show or hide the toolbar, icon descriptions or 
make the icons larger. 
 
The Navigation Window is the small pop up box in 
the RootSnap workspace.  Touching the 
Navigation Window will jump to that section of the 
root image.  The Navigation Window menu allows the user to make the Navigation Window 
Visible, enable Snap to Grid or Show the Grid.  Right-clicking on the Navigation Window will 
also bring up the Navigation Window menu.  
 

 To change the current viewable area, click or touch a specific area on the Navigation 
Window.  

 To view the Navigation Window, select <View>< Navigation Window><Visible>. 

 To show a grid over the Navigation Window, press Control+G or select 
<View><Navigation Window><Show Grid>. 

 To snap to the grid when using the Navigation Window, press Control+Shift+G or 
select <View><Navigation Window><Snap to Grid>. 
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 Selecting “Zoom” from the View menu allows for adjustment to the zoom of the image. 

 Select “Zoom Out” or press Control and – on the keyboard to zoom 
out on the image.  

 Select “Zoom In” or press Control and + on the keyboard to zoom in 
on the image.   

 Select “100%” or press Control + 0 on the keyboard to reset the 
zoom to 100% or full size.   

 Selecting <Layers><Previous Root Mappings> will either show or hide root mappings 
from the previous session.   

 The Details Panels that pop out on the left and right sides of the RootSnap! workspace 
can be accessed by navigating to View<Panels 

 Select <View><Panels><Tube Details> or press Alt + T to show the 
Tube Details panel. 

 Select <View><Panels><Image Details> or press Alt + I to show the 
Image Details panel. 

 Select <View><Panels><Point Details> or press Alt + P to show the 
Point Details panel. 

 Select <View><Panels><Root Details> or press Alt + R to show the 
Root Details panel. 
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Detail Panel Descriptions 

Tube Details Panel 

The Tube Details panel allows the user to easily 
navigate and manage the current project by jumping to 
different sessions, tubes or windows.  The Tube Details 
panel can also be used to expand projects, adding new 
windows, tubes and sessions using the green “+” button.   

 

1. To view the Tube Details panel, enable it from 
the <View><Panels><Tube Details> on the 
menu bar 

2. Use the black arrow at the bottom of the panel 
to expand or hide the tube details panel.   

a. The Tube Details panel appears on the 
left side of the RootSnap! workspace.  

3. The depth of each window from the top of the 
imaged area can be seen on the left side of the 
window preview section.  Window 1 is the 
window closest to the surface of the soil with a 
depth of 0 cm.  Window 2 has a depth of 196 cm 
and Window 3 begins at 392 cm below ground.  

4. Right-click on a window in the Tube Details 
Panel to enable the Tube Details Menu, shown 
below.   

a. The tube Details Menu includes options 
to change the image by importing 
another image and to rotating or flipping 
the image. 

b. If the Window Alignment feature is 
available, it is also shown as an option. 
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Image Details Panel 

The Image Details panel displays information about 
the image currently active in RootSnap!.  The top of 
the Image Details panel shows the “Date & Time 
Scanned.”  This is the date and time that the image 
was created.  If the image was acquired with a CI-
600, the timestamp should import properly.  If the 
image was taken with a flat-bed scanner or digital 
camera, the timestamp may need to be adjusted to 
the actual date/time the root image was taken.  The 
time is on a 24-hour clock to eliminate confusion.   
 
The “Physical Size” of the image is displayed in 
millimeters.  Check that the image’s Physical Size is 
correct.  If the actual size of the image is not correct, 
change it to the correct size before starting to 
analyze roots.  CI-600 images are 215.9 mm x 195.7 
mm.  The DPI and Pixel count are automatically 
adjusted to render this size.  Typically the DPI, 
Pixels and Actual Size values do not need to be 
changed from the values automatically tagged with 
the image.   
 
The units that the data is reported in are 
automatically chosen by the program, determined 
by what fits the data set the best.  The data can be 
reported in millimeters, centimeters or meters.   
 

1. To access the Image Details Panel, navigate 
to <View<Panels><Image Details>.   

2. The panel will appear on the right side of 
the screen when enabled.   
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Point Details Panel 

The Point Details panel displays the diameter details 
of the currently selected root point, and other points 
on the root, as shown in the example to the right.  
 

1. Click <View><Panels><Point Details> option 
to show or hide this feature. 

2. To expand/hide the Point Details panel, press 
the arrow at the bottom of the bar.  The Point 
Details will appear on the right side of the 
workspace. 

3. To change the Current Point displayed in the 
Point Details panel, select any point using the 
Add/Edit Points tool or choose a point from 
the list.   

4. To change the diameter of a point, select the 
point on the root map.  Use the mouse wheel 
or pinch the point in/out until the gray circle 
is as large as the root. The correct diameter 
can also be entered numerically into the Point 
Details panel.   
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Root Details Panel  

This feature allows the user to view the morphological 
details of the current root including numerical data 
such as root area, volume, diameter and length, as seen 
in the example Root panel to the right.  Also reported in 
the root details panel is the root angle, branch angle 
(only reported if segment is a branch), and the start 
and end tip angles of the root.   

1. To hide or show this feature: select 
<View><Panel><Root Details>. 

2. To expand or minimize the Root Details panel 
off to the side, press the small arrow at the 
bottom of the panel. 

3. To change the current root displayed in the 
Root Details panel:  

a. Select any point on the root using 
the <Add/Edit Points> tool. 

4. The “Selected Root” drop-down list at the top of 
the Root Details panel.  The drop-down list in 
the Root Bar is organized so that branches (sub-
roots) are with their parent root and are color-
coded. 

 

 

 

 

 

 

 

 

 

 

The Root Details panel contains the statistics for total root length, total area of the selected 
root, root volume, average diameter of root points on the root, root angle, and if applicable, 
branch angle.  The start and end tip angles of the root are also reported.  RootSnap! 
calculates root volume by assuming a cylindrical shape for the roots. The application uses 
this assumption to extrapolate point diameter and root length into root volume data in 
mm3, cm3, or m3 (whichever unit fits the data best).  
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HELP MENU 

The Help Menu contains the Release Notes and the “About” information pop-up box.  The 
Release Notes are the fixes, corrections or additions made to the software in the latest 
release or version.  The “About” pop-up screen contains information about the license key of 
the application, checking for updated versions, and requesting license key activation. 
 

EXPORTING DATA 

Data from RootSnap! projects, tubes, windows or sessions can be exported to be opened as a 
spreadsheet.  Exported data is saved as .csv (comma separated value) files which can be 
opened using Microsoft Excel or similar programs and saved as various other file types. The 
user has a choice of which data is exported and can select individual sessions to the entire 
project to be exported as a single .csv file.  After selecting which sessions to export, the user 
then has a choice of what data fields to include in the exported data file.  By default, several 
data fields will not be exported.  Desired data fields can be set before exporting.   
 
The data fields that are available to export are broken down into 5 levels: tube data, 
window data, session data, root data and point data.  The individual data fields available for 
each are shown in Table 3.  
 

Table 3: Date fields that can be exported in a .csv file from a RootSnap! project. 

TUBE WINDOW SESSION ROOT POINT 

Tube ID Tube ID Tube ID Tube ID Tube ID 

Tube Ordinal Tube Ordinal Tube Ordinal Tube Ordinal Tube Ordinal 

Root Count Window Ordinal Window Ordinal Window Ordinal Window Ordinal 

Total Root Length Depth Session ID Session ID Session ID 

Total Root Volume Root Count Session Ordinal Session Ordinal Session Ordinal 

Total Root Area Total Root Length Date and Time Session Date Session Date 

Average Root Diameter Total Root Volume Physical Size Parent Root ID Root ID 

Average Root Length Total Root Area Image Size Root ID Location 

Average Root Area Average Root Diameter Root Count Root Ordinal Point Ordinal 

Average Root Volume Average Root Length Total Root Length Root Alias Diameter 

 Average Root Area Total Root Volume Status  

Average Root Volume Total Root Area Length 

 Average Root Diameter Average Diameter 

Average Root Length Area 

Average Root Area Volume 

Average Root Volume Root Angle 

 Branching Angle 
Branch Count 
Start Tip Angle 
End Tip Angle 
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Root data is displayed at the top of the file including the root id, length, average diameter, 
area, volume, mean angle, branch count, branch ids and point count.  Below the root data is 
the point data, such as the sample location (X, Y axis values for point), diameter, angle and 
mapping method (manual or automatic from Find Roots feature).  Also shown is the 
brightness distribution score, gradient detection score and root behavior score for each 
point.   

 

1. To export data from a Project, 
select File <Export>. 

2. Choose which Tubes, 
Windows or Sessions to 
export data from.  Data to 
export will have an orange 
square next to it.   

 

 

 

 

 

 

3. Choose which data fields to 
include in the exported data 
file. 

4. The “point” fields are disabled 
by default to eliminate excess 
data. The default export 
setting will provide the 
average diameter of the root 
or branch.  If individual point 
diameter is needed, select this 
data field to export. 
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5. To save the exported data, 
type the desired file name 
and press save it as .csv. 

6. The .csv file will be saved in 
the “Document<RootSnap!” 
folder.   

7. Choose “Include Images” to 
save a copy of the original 
root image (without 
mappings) with the .csv. 

8. The feature to “Include roots 
in images” will be available in 
a later version. 

9. Click “Next” or “Done” to 
begin exporting the data.  
During the export process, 
you can minimize the 
RootSnap! application. 

 

 

 

 

 

 

 

10. When the export is complete, 
there will be the option to 
open the file and view the 
data immediately. 

 

 

 

 

The next page of this manual is an example spreadsheet of the data that is exported by 
default.  The spreadsheet is split in two so that it can be viewed on a single page.  All values 
are in millimeters and Project, Tube and Window totals reflect the current totals for the 
latest session. 
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TROUBLESHOOTING 

Technical Support 
If you have a question about the CI-690 software features and functions, first look in the CI-
690 Help Menu or User Guide. If you cannot find the answer, you can access troubleshooting 
information and the CI-690 Product Support Forum at: 

 
http://www.cid-inc.com/support/9-product-support/29-product-support-root-image-analysis-system-ci-690 

 
Questions can also be directed to a Technical Support Representative located in your 
country.  CID Bio-Science, Inc. is committed to provide customers with high quality, timely 
technical support. Technical support representatives are to answer your technical questions 
by phone or by e-mail at: 

 
support@cid-inc.com. 

 
CID Bio-Science, Inc.’s contact information:  
 

CID Bio-Science, Inc. 
1554 NE 3rd Ave. 

Camas, WA 98607 USA 
 

Phone: 800-767-0119 (U.S. and Canada) 
360-833-8835 

Fax: 360-833-1914 
 

Internet: http://www.cid-inc.com 
E-mail: support@cid-inc.com 

 

Customer Service 
Customer Service Representatives answer questions about specifications and pricing, and 
sell all of the CID Bio-Science, Inc. products. Customers sometimes find that they need CID 
Bio-Science, Inc. to upgrade, recalibrate or repair their system. In order for CID Bio-Science, 
Inc. to offer these services, the customer must first contact us and obtain a Return 
Merchandise Authorization (RMA) number. Please contact a customer service 
representative for specific instructions when returning a product. 

http://www.cid-inc.com/support/9-product-support/29-product-support-root-image-analysis-system-ci-690
mailto:support@cid-inc.com
mailto:support@cid-inc.com
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Tips 

Keyboard Shortcuts 

 
The following keyboard shortcuts can be used with RootSnap!: 

 

 Control + O: open a project 

 Control + S: save a project 

 Control + A: save a project as 

 Control + I: import an image 

 Control + Z: undo the previous action 

 Control + Y: redo 

 Control + LEFT: next session in the project 

 Control + RIGHT: previous session in the project  

 Control + -: zoom out 

 Control + +: zoom in 

 Control + 0: zoom 100% 

 Alt + T: view the Tube Details panel 

 Alt + I: view the Image Details panel 

 Alt +R: view the Root Details panel 

 Alt +P: view the Point Details panel  

 Control+G: show grid over Navigation Window  

 Control+Shift+G: snap to grid for Navigation Window 

 

Mouse Shortcuts 

The following keyboard shortcuts can be used with RootSnap!: 
 

 Use center wheel to zoom in/out when Pan & Zoom is enabled. 

 With Add/Edit Points selected, draw with the left mouse click and remove 
points with the right mouse click 

 Push the center wheel to pan or move around. 

 Click on a point and then scroll the mouse wheel to adjust the diameter of 
the point. 

 Push and scroll the wheel to jump between sessions when the tube details 
panel is selected. 
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Frequently Asked Questions 

1. Where do I download the most current version of CI-690 RootSnap! software?   

o The latest version of software can be downloaded at http://www.cid-
inc.com/support/software-downloads.  Click the “Install” button at the 
bottom of the page to begin the download.  Windows Installer 4.5 and 
Microsoft .NET Framework 4 (x86 and x64) are required.   

2. How does the click-once automatic update work?   

o If the computer has an internet connection when the RootSnap! software is 
opened, the click-once application will check if there is an update available.  
If an update has been released, there will be an option to download the 
update or to skip the download.  It is recommended to download the update.  
Information on the changes in each new version can be found in the “Release 
Notes” in the “Help” menu.   

3. How can I change the size of the image, if it is not imported properly? 

o To check if the actual size of the image is correct, or to change it to the 
correct size before starting to analyze roots,  access the Image Details Panel 
by navigating to <View><Panels><Image Details>.  

o The “Physical Size” of the image is displayed in millimeters.  Check that the 
image’s Physical Size is correct.  If the actual size of the image is not correct, 
change it to the correct size before starting to analyze roots.   
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ROOTSNAP! SOFTWARE AGREEMENT 

Trademark Acknowledgments 
The information in this manual is proprietary to CID Bio-Science, Inc. and may not be 
reproduced in part or whole without written permission of CID Bio-Science, Inc.  All rights 
reserved.  

 Microsoft® Windows® operating system is a trademark or copyright of 
Microsoft Corporation in the U.S.A. and other countries. 

 Windows® NT, Windows 2000, Windows 2003 and Windows 7 are 
trademarks or copyrights of Microsoft Corporation in the U.S.A. and other 
countries. 

 IBM and PC/AT are trademarks of International Business Machines 
Corporation. 

 All other trademarks and copyrights are the property of their respective 
owners. 

====================================== 
CID Bio-Science, Inc. 
ROOTSNAP! SOFTWARE AGREEMENT 
====================================== 

 
IMPORTANT: This Agreement contains the exclusive terms and conditions that govern the 
use by you ("you" or "Customer") of software to be distributed by CID Bio-Science Inc., for 
Your internal use, non-commercial use and demonstration. By clicking on the "AGREE" 
button or entering "yes" in response to the electronic license acceptance query, or installing, 
electronically downloading, or using the Software, you are agreeing to the terms and 
conditions of this Agreement.  If you do not agree to the terms of this Agreement, then do 
not use or copy the Software, and click on the "Disagree." 

 
The parties agree as follows: 
1.  Installation and Use.  Subject to Customer's compliance with the terms and conditions of this 
Agreement, CID Bio-Science, Inc. hereby grants Customer a limited, non-exclusive, non-transferable 
right to install and use the Software in Customer's operating environment(s) with third-party 
products or software solely for research and evaluation purposes.   

 
2.  Other Limitations.  Customer agrees not to modify, adapt or translate the Software and further 
agrees not to attempt to reverse engineer, decompile, disassemble or otherwise attempt to discover 
the source code of the Software. Customer may not rent, lease, distribute or lend the Software to 
third parties. The Software may not be reproduced, stored in a retrieval system or transmitted, in any 
form or by any means without prior written consent of CID Bio-Science, Inc.  The Software is licensed 
as a single unit and its component programs may not be separated for some other use. Further, 
Customer agrees not to place the Software onto a server so it is accessible via a public network such 
as the Internet.  
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3.  Responsibility for Testing.  Customer acknowledges that Customer is solely responsible for 
selecting the demonstration environment, configuring or interfacing the Software with the third-
party products or software in Customer's operating and test environments, and the results of the 
tests.  Customer accepts, or will manage the use of the software so as to avoid, any risk to Customer, 
its business, employees or customers arising from the demonstration. Customer assumes full 
responsibility for selecting any demonstration Site(s), and for informing Customer's employees (and, 
if necessary, appropriate or required by law, Customer's customer(s)) of the material provisions of 
this Agreement.  CID Bio-Science, Inc. will not provide any on-site service or support for the Software 
at demonstration sites or otherwise (except as specified in writing) and accepts no responsibility 
whatsoever for Customer's use of the Software. Customer further acknowledges that this is a 
demonstration and that the Software is not for sale (and may undergo changes in its form, fit or 
function after, or even during the period that it is installed at the customer site (s) 

 
4.  Ownership.  Title, ownership rights, and intellectual property rights in and to the Software shall 
remain with CID Bio-Science, Inc. or its suppliers. The Software is protected by United States 
Copyright Law and international copyright treaties, as well as other intellectual property laws and 
treaties.  There is no transfer to you of any title to or ownership of the Software and this License shall 
not be construed as a sale of any rights in the Software. CID Bio-Science, Inc. and its suppliers reserve 
all rights not granted. 

 
5.  Proprietary Notices and Record Keeping.  You agree to respect and not to remove, obliterate or 
conceal from view any copyright, patent, trademark, confidentiality or similar notice, mark or legend 
appearing on the Software or Confidential Information or any output generated thereof. 

 
6.  NO WARRANTY.  The Software and the Confidential Information is provided "AS IS," without any 
warranty, express or implied of any kind, including without limitation the warranties of 
merchantability, fitness for a particular purpose, title and non-infringement.  This disclaimer of any 
and all warranties must be communicated to employees, and, if appropriate, Customer's customers 
by Customer, who hereby indemnifies and holds CID Bio-Science, Inc. harmless from and against any 
failure to so inform said parties.  Customer acknowledges that CID Bio-Science, Inc. has not publicly 
announced the availability of the Software, that CID Bio-Science, Inc. has not promised or guaranteed 
to Customer that such Software will be announced and made available for sale to anyone in the 
future, and that CID Bio-Science, Inc. has no express or implied obligation to develop and to announce 
or produce the Software, or any similar or compatible product.   

 
7.  DISCLAIMER OF LIABILITY. Customer expressly acknowledges and agrees that any testing or 
experimenting that it performs with respect to the Software is entirely at Customer's own risk and 
expense. CID BIO-SCIENCE, INC. WILL NOT BE LIABLE FOR ANY DIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, WHETHER ARISING IN TORT (INCLUDING NEGLIGENCE), CONTRACT 
OR OTHERWISE, THAT STEM FROM ANY USE OF CONFIDENTIAL INFORMATION OR THE 
SOFTWARE OR CID BIO-SCIENCE, INC.’S PERFORMANCE OR FAILURE TO PERFORM UNDER THIS 
AGREEMENT. 
 
8.  Export Restrictions and Reservation of Rights.  Customer certifies that neither the Software 
nor the Confidential Information nor any portion thereof will be exported to any country in violation 
of any applicable laws including, without limitation, the United States Export Administration Act and 
regulations there under, as applicable.  



CI-690 RootSnap! Operations Manual rev.1/24/14 

 

1554 NE 3rd Ave, Camas, WA 98607, USA  

Phone (360) 833-8835 Fax (360) 833-1914   sales@cid-inc.com   http://www.cid-inc.com 
46 

 

 

9.  Term and Termination.  This Agreement will continue in effect for so long as Customer is 
engaged in using as specified above.  Customer agrees to discontinue the use as specified above upon 
request by an authorized representative of CID Bio-Science, Inc.  Following termination of this 
Agreement for any reason, the provisions of this Agreement with respect to non-disclosure and 
limited use of the Software, indemnification, and warranty and liability disclaimers, will survive.  
Upon termination of this Agreement, Customer shall cease using, and upon request, return to CID 
Bio-Science, Inc. all materials, data, documentation and information constituting or relating to the 
Software, including all copies and regardless of the form or media on which same is contained.  At the 
request of CID Bio-Science, Inc., Customer shall certify that the terms of this Section have been 
complied with. 

 
10.  Entire Agreement and Governing Law.  This Agreement: (a) constitutes the entire Agreement 
with respect to the Software.  It supersedes all prior or contemporaneous oral or written agreements 
concerning the Software and; (b) may not be amended except by the written agreement signed by 
authorized representatives of both parties; (c) will be governed by and in accordance with the laws 
of the State of Washington as applied to agreements and to be performed entirely within Washington 
with Washington residents, and is not governed by the United Nations Convention on Contracts for 
the International Sale of Goods, the application of which is expressly excluded.  The parties agree that 
any litigation relating in any way to this Agreement shall be filed and initiated in and only in Camas, 
Washington and the parties consent to personal jurisdiction and venue in the Federal and State 
Courts in Camas, Washington. 


